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Working with Advanced 

Drawing Options
    Chapter OBJECTIVES
In this chapter, you will learn:
• To define multiline style and specify the properties of multilines using the 
MLSTYLE command.

• To draw various types of multilines using the MLINE command.
• To edit multilines using the MLEDIT command.
• To draw NURBS splines using the Spline tool.
• To edit NURBS splines using the Edit Spline tool.



17-2 AutoCAD LT 2013 for  Des igners

Understanding the Use of Multilines
The Multiline feature allows you to draw composite lines that consist of multiple parallel lines. 
Multilines consist of parallel lines, which are called elements. You can draw these lines with the 
MLINE command. Before drawing multilines, you need to set the multiline styles. This can 
be accomplished by using the MLSTYLE command. Also, you can edit multilines by using the 
MLEDIT command.

Defining the Multiline Style
  Menu Bar:    Format > Multiline Style		  Command:   MLSTYLE   

You can create the style of multilines by using the MLSTYLE command. You can specify the 
number of elements in a multiline and the properties of each element. The style also controls the 
start and end caps, the start and end lines, and the color of multilines and fill. When you invoke 
this command, AutoCAD LT displays the Multiline Style dialog box (Figure 17-1). Using this 
dialog box, you can set the spacing between parallel lines, specify linetype pattern, set colors, 
solid fill, and capping arrangements. By default, the multiline style (STANDARD) has two lines 
that are offset at 0.5 and -0.5.

Figure 17-1  The Multiline Style dialog box

Note
You cannot modify the style of a multiline that is used in the current drawing. You first need to 
delete the multiline from all the places where it is used and then you can modify its style.

Styles List Box
The Styles list box displays the names of the styles. By default, the STANDARD style is available 
in this list box. If several styles have been defined, all of them will be listed in this list box.

Set Current
If several styles have been defined, select a style from the Styles list box and choose the Set 
Current button to make the style as the current style. The current multiline style is saved in the 
CMLSTYLE system variable. 
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New
The New button is chosen to create a new 
multiline style. On choosing this button, the 
Create New Multiline Style dialog box will be 
displayed, as shown in Figure 17-2. The New 
Style Name edit box is used to specify the name 
of the new multiline style you want to define. The 
Start With drop-down list will be available only if 
some styles have already been defined. You can 
select an existing style as a reference to create 
the new style. The new style will start with the 
properties associated with the style selected from 
the Start With drop-down list. As soon as you specify the name of the new style, the Continue 
button is highlighted. To create a new style, enter the name of the new style in the New Style 
Name edit box and then choose the Continue button; the New Multiline Style dialog box will 
be displayed, as shown in Figure 17-3.

Figure 17-3  The New Multiline Style dialog box

The title bar of the New Multiline Style dialog box displays the name of the new style. By default, 
some properties in the dialog box are defined at some preset values. These values correspond to 
the selection made in the Start With drop-down list. 

Description
This edit box used to specify the description of the new multiline style. The description, including 
spaces, can be up to 255 characters long. Giving information in this edit box is optional so you 
can leave it blank if you want.

Caps Area
The options under this area are used to set the type and location of the start and end caps of 
the multilines. These options are discussed next.

Line. Selecting the Start and End check boxes of this option caps the multiline with a line 
at the start point and the endpoint (Figure 17-4). 

Outer arc. Selecting the Start and End check boxes of this option draws a semicircular arc 
between the endpoints of the outermost lines (Figure 17-4).

Figure 17-2  The Create New Multiline Style 
dialog box
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Figure 17-4  Drawing multilines with different end cap specifications

Inner arcs. This option is used to draw a semicircular arc between the two innermost lines 
at the start point and endpoint of a multiline. The arc is drawn between the even-numbered 
inner lines (Figure 17-4). For example, if there are two inner lines, an arc will be drawn at 
their ends. On the other hand, if there are three inner lines, the two outer lines are capped 
with the arc and the middle line is not capped.

Angle. By default, the end caps of a multiline are drawn tangentially to the multiline elements, 
that is, the angle the cap makes with the multiline elements is 90 degree. You can  control 
the cap angle at the start and end of a multiline by entering angles in the corresponding 
Angle edit boxes (Figure 17-4). This angle can be between 10 degree and 170 degree.

Fill Area
The options under this area are used to fill the multiline with a specified color.  By default, None 
is selected in the Fill color drop-down list. As a result, there is no fill effect in the multiline. To 
specify a fill color, select it from this drop-down list. Selecting the Select Color option displays 
the Select Color dialog box, wherein you can select additional colors.

Display joints
If you select the Display joints check box, AutoCAD LT will draw a line across all elements 
of the multiline at the vertex points, where the multiline changes direction. The joints of the 
multiline are also called miter joints. If you draw only one multiline segment, no line is drawn 
at the miter joint.

Elements Area
The options in this area modify the element properties of the multiline style. The element 
properties include the number of lines, color, and linetype of the lines comprising the multiline. 
The following options are available for setting the properties of the individual lines (elements) 
that constitute the multiline.

Offset, Color, and Linetype
This list box displays the offset, color, and linetype of each line that constitutes the current 
multiline style. The lines are always listed in the descending order, based on the offset distance. 
For example, a line with a 0.5 offset will be listed first and a line with a 0.25 offset will be 
listed next. You can select an element to be modified from the list box; the selected element is 
highlighted.
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Add
This button allows you to add new lines to the current line style. The maximum number of 
lines that you can add is 16. When you choose the Add button, AutoCAD LT inserts a line with 
the offset distance of 0.0, Color = BYLAYER, and Linetype = Bylayer. The new element gets 
added between two existing elements. After the line is added, you can change its offset distance, 
color, or linetype. The offset distance can be entered in the Offset edit box. Similarly, you can 
select the options in the Color drop-down list to specify a color for the selected element of the 
multiline. Also, you can choose the Linetype button to display the Select Linetype dialog box. 
You can use this dialog box and its options to load and select the linetype you want to apply to 
the selected element of a multiline. 

Delete
This button allows you to delete a selected element from the multiline style. The highlighted 
element is removed from the Elements list box.

Offset
This edit box allows you to change the offset distance of the selected line in the Elements list 
box. The offset distance is defined with respect to the origin (0,0). The offset distance can be a 
positive or a negative value, which enables you to center the lines.

Color
This drop-down list allows you to assign a color to the selected line. When you choose the Select 
Color option from the drop-down list, AutoCAD LT displays the Select Color dialog box. You 
can select a color from the dialog box or enter a color number or name in the Color edit box.

Linetype
This button allows you to assign a linetype to the selected line. When you choose this button, 
AutoCAD LT displays the Select Linetype dialog box. After selecting a linetype in this dialog 
box, choose OK to exit. You can also choose the Load button in the Select Linetype dialog 
box to display the Load or Reload Linetypes dialog box, where you can select a linetype you 
want to use. The selected linetype is displayed in the Loaded Linetype list box of the Select 
Linetype dialog box. You can now select the specific linetype and apply it to a selected element 
of a multiline.

After you have added the elements to a multiline and set their properties, choose OK button to 
exit the New Multiline Style dialog box. An image of the current multiline style is displayed in 
the Preview of area in the Multiline Style dialog box. The new style is now listed in the Style 
list box.

Load
Choose this button from the Multiline Style dialog 
box to load a multiline style from an external multiline 
library file (acad.mln). On choosing this button, the 
Load Multiline Styles dialog box will be displayed, 
as shown in Figure 17-5. This dialog box displays all 
multiline styles available in the current mln directory. If 
the style is saved in another directory or file, choose the 
File button to display the Load Multiline Style From 
File dialog box and then select the multiline file that 
you want to load. Once the file is loaded, all styles saved 
under it are displayed in the list box. You can select the 
style and then choose OK to make it current.

Figure 17-5  The Load Multiline Styles 
dialog box
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Save
This button lets you save a multiline style to an external file (.mln). When you choose this button, 
AutoCAD LT displays the Save Multiline Style dialog box. This dialog box lists the names of 
the available predefined multiline style files (.mln). From the file listing, select or enter the name 
of the file where you want to save the current multiline style and choose the Save button. By 
default, the multiline styles get saved in the acad.mln file at the location C:\Users\<user name>\
AppData\Roaming\Autodesk\AutoCAD LT 2013\R19.0\enu\Support. 

Rename
This button allows you to rename the current multiline style. To do so, select the multiline style to 
be renamed and choose the Rename button; the text will be displayed in an edit box. Rename the 
text and click once on the list box. Note you cannot rename the STANDARD multiline style.

Preview of Area
The Multiline Style dialog box also displays the current multiline configuration in the Preview of 
area. The panel will display the color, linetype, caps and relative spacing of the lines. As you select 
another multiline style, the image in the preview area also gets updated accordingly. The name 
of the multiline style whose preview is being shown is displayed above the Preview of area.

Drawing Multilines
  Menu Bar:  Draw > Multilines		  Command: MLINE or ML  

The MLINE command is used to draw multilines. The following is the prompt sequence for 
the MLINE command:

Current settings: Justification = Top, Scale = 1.00, Style = STANDARD
Specify start point or [Justification/Scale/STyle]: Select a start point or enter an option.
Specify next point: Select the second point.
Specify next point or [Undo]: Select the next point or enter U for undo.
Specify next point or [Close/Undo]: Select the next point, enter U, or enter C for close. You can also 
right-click to display the shortcut menu and choose Enter, Cancel, Recent Input, Dynamic Input 
Close, Undo, Snap overrides, Pan, Zoom, SteeringWheels, or Quick calc.

When you invoke the MLINE command, it always displays the current status of the multiline 
justification, scale, and style name. Remember that all line segments created in a single MLINE 
command are a single entity. The options provided under this command are discussed next.

Justification Option
The justification determines how a multiline is drawn between the specified points. Three 
justifications are available for the MLINE command. They are Top, Zero, and Bottom.

Top
This justification produces a multiline in which the top line coincides with the points you selected 
on the screen. Since the line offsets in a multiline are arranged in descending order, the line with 
the largest positive offset will coincide with the selected points. This is the default justification 
option, see Figure 17-6.

Zero
This option will produce a multiline in which the zero offset position of the multiline coincides 
with the selected points. Multilines will be centered if the positive and negative offsets are equal, 
see Figure 17-6.



17-7Working with  Advanced  Drawing Options
C

h
a

p
te

r
 1

7

Bottom
This option will produce a multiline in which the bottom line (the line with the least offset 
distance) coincides with the selected point when the line is drawn from the left to right, see 
Figure 17-6.

Scale Option
The Scale option is used to  change the scale of a multiline. For example, if the scale factor is 0.5, 
the distance between the lines (offset distance) will be reduced to half, as shown in Figure 17-7. 
Therefore, the width of the multiline will be half of what was defined in the multiline style. A 
negative scale factor will reverse the order of the offset lines. The multilines will now be drawn 
such that the line with the maximum negative offset distance is at the top and the line with 
the maximum positive offset distance is at the bottom. For example, if you enter a scale factor 
of -0.5, the order in which the lines are drawn will be reversed, and the offset distances will be 
reduced by half. Here it is assumed that the lines are drawn from left to right. If the lines are 
drawn from right to left, the offsets are reversed. Also, if the scale factor is 0, AutoCAD LT forces 
the multiline into a single line. However, the line will still possess the properties of a multiline. 
This scale factor does not affect the linetype scale factor (LTSCALE).

Figure 17-6  Justifications in multilines Figure 17-7  Different multiline scales

STyle Option
The STyle option allows you to change the current multiline style. The style must be defined 
before using the STyle option to change the style.

Note
All options explained above are available at the dynamic prompt. To access the options through 
dynamic prompt, press the down arrow key from the keyboard whenever dynamic prompting is 
available at the cursor. Now, select the option using the cursor.

Editing Multilines by Using Grips
Multilines can be easily edited using grips. When you select a multiline, the grips appear at 
the endpoints, based on the justification used when drawing multilines. For example, if the 
multilines are top-justified, the grips will be displayed at the endpoint of the first (top) line 
segment. Similarly, for zero and bottom-justified multilines, the grips are displayed on the 
centerline and bottom line, respectively.

Note
Multilines do not support certain editing commands such as BREAK, CHAMFER, and  
FILLET. However, commands such as COPY, MOVE, ROTATE, MIRROR, STRETCH, 
SCALE, and EXPLODE as well as most object snap modes can be used with multilines. 
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Tip
You must use the MLEDIT command to edit multilines. The MLEDIT command has several 
options that make it easier to edit these lines.

Editing Multilines by Using the Dialog Box
 Menu Bar:  Modify > Object > Multiline		 Command:  MLEDIT 

When you invoke the MLEDIT command, AutoCAD LT displays the Multilines Edit Tools dialog 
box, see Figure 17-8. This dialog box contains five basic editing tools. To edit a multiline, first 
select the editing operation you want to perform by clicking on the image tile. Once you have 
selected the editing option, AutoCAD LT will prompt you to select the first and second multilines. 
After editing one set of multilines, you will be prompted again to select the first multiline or 
undo the last editing. Press Enter to exit this command after you have finished the editing. 

Figure 17-8  The Multilines Edit Tools dialog box

The following is the list of options for editing multilines:

Cross Intersection
Closed Cross (CC), Open Cross (OC), Merged Cross (MC)

Tee Intersection
Closed Tee (CT), Open Tee (OT), Merged Tee (MT)

Adding and Deleting Vertices
Add Vertex (AV), Delete Vertex (DV)

Cutting and Welding Multilines
Cut Single (CS), Cut All (CA), Weld All (WA)

Cross Intersection (CC/OC/MC)
With the MLEDIT command options, you can create three types of cross intersections: closed, 
open, and merged. You must be careful about the order in which you select multilines for 
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editing. The order in which multilines are selected determines the edited shape of a multiline 
(Figure 17-9). The cross intersection can belong to a self-intersecting multiline or two different 
multilines. 

Figure 17-9  Three types of cross intersections

When you invoke the MLEDIT command, the Multilines Edit Tools dialog box is displayed. 
Choose the Closed Cross image tile; the dialog box disappears from the screen and the following 
prompts appear in the Command prompt:

Select first mline: Select the first multiline.
Select second mline: Select the second multiline.
Select first mline or [Undo]: Select another multiline, press ENTER to end the command, or enter 
U to undo the last operation.

If you enter U, AutoCAD LT will undo the last editing operation and prompt you to select the 
first multiline. However, if you do not enter U and select another multiline, AutoCAD LT will 
prompt you to select the second multiline. 

Tee Intersection (CT/OT/MT)
With the MLEDIT command options, you can create three types of tee-shaped intersections: 
closed, open, and merged. As with the cross intersection, you must be careful how you select the 
objects because the order in which you select them determines the edited shape of a multiline 
(Figure 17-10). The prompt sequence for the tee intersection is the same as that for the cross 
intersection.

Figure 17-10  Three types of tee intersections
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When you invoke the MLEDIT command, the Multilines Edit Tools dialog box is displayed. 
Choose the Closed Tee image tile; the dialog box disappears from the screen and the following 
prompts appear in the Command prompt.

Select first mline: Select the first multiline.
Select second mline: Select the intersecting multiline.
Select first mline or [Undo]: Select another multiline, enter U to undo the last operation, or press 
Enter to end the command.

Corner Joint (CJ)
The Corner Joint option is used to create a corner joint between the two selected multilines. The 
multilines must be two separate objects (multilines) or self-intersecting multilines (Figure 17-11). 
When you specify two multilines, AutoCAD LT trims or extends the first multiline to intersect with 
the second one. The prompt sequence that follows when you invoke this option is given next.

Select first mline: Select the multiline to trim or extend.
Select second mline: Select the intersecting multiline.
Select first mline or [Undo]: Select another multiline, enter U to undo the last operation, or press 
Enter to end the command.

Figure 17-11  Editing corner joints 

Adding and Deleting Vertices (AV/DV)
You can use the MLEDIT command to add or delete the vertices of a multiline (Figure 17-12). 
When you select a multiline for adding a vertex, AutoCAD LT inserts a vertex point at the point 
where you clicked on the object while selecting it. Later, you can move the vertex by using grips. 
Similarly, you can also use the MLEDIT command to delete vertices by selecting the object 
whose vertex point you want to delete. AutoCAD LT removes the vertex that is nearest to the 
point where you click to select the multiline segment.

When you invoke the MLEDIT command, the Multilines Edit Tools dialog box is displayed. 
Choose the Add Vertex image tile; the dialog box is removed from the screen and the following 
prompts appear in the Command prompt.

Select mline: Select the multiline for adding vertex.
Select mline or [Undo]: Select another multiline for modifications; enter U to undo the last operation, 
or press Enter to exit the command.
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A same prompt sequence appears at the Command prompt when you use the Delete Vertex 
option.

Cutting and Welding Multilines (CS/CA/WA)
You can also use the MLEDIT command to cut or weld multilines. When you cut a multiline, it 
does not create two separate multilines. They continue to be a part of the same object (multiline). 
You can cut away an area from any of the elements of a multiline or from the entire multiline. 
Also, the points selected for cutting the multiline do not have to be on the same element of the 
multiline (Figure 17-13). You can select the two points that define the cut on different elements 
of the multiline. When cutting a single element of the multiline, if you select the two cut points 
on different elements, the element you selected first gets cut by the distance defined by the two 
points.

Figure 17-12  Adding and deleting vertices Figure 17-13  Cutting and welding multilines

In the Multilines Edit Tools dialog box, choose the Cut Single image tile; the dialog box is 
removed from the screen, and the following prompts appear in the Command prompt.

Select mline: Select the multiline. 
(The point where you select the multiline specifies the first cut point.)
Select second point: Select the second cut point.
Select mline or [Undo]: Select another multiline to cut, enter U to undo the last operation, or press 
Enter to exit the command.

The Weld option reconnects the multilines that have been cut by using the Cut Single or Cut All 
option of the MLEDIT command (Figure 17-13). You cannot weld or join separate multilines.
In the Multilines Edit Tools dialog box, choose the Weld All image tile; the dialog box is 
removed from the screen, and the following prompts appear in the Command prompt.

Select mline: Select the multiline.
Select second point: Select a point on the other side of the cut.
Select mline or [Undo]: Select another multiline to modify, enter U to undo the last operation, or 
press Enter to exit the command.

Note
The following system variables store values for various aspects of multilines. The CMLJUST 
variable stores the justification of the current multiline (0-Top, 1-Middle, 2-Bottom). The 
CMLSCALE variable stores the scale of the current multiline (Default scale = 1.0000) 
and the CMLSTYLE variable stores the name of the current multiline style (Default 
style = STANDARD).
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Tip
You can also edit multilines by entering the -MLEDIT command at the pointer input. All options 
are displayed at the dynamic prompt, see Figure 17-14.

Figure 17-14  Dynamic prompt 
for the -Mledit command

Example 1 								        MLINE
In this example, you will create a multiline style that represents a wood-frame wall system. The 
wall system consists of ½” wallboard, 4 X ½”  wood stud, and ½” wallboard.

1.	 Enter MLSTYLE at the Command prompt to display the Multiline Style dialog box. Also, 
the current style, STANDARD is displayed in the Styles list box. 

2.	 Choose the New button to invoke the Create New Multiline Style dialog box. Enter 
MYSTYLE in the New Style Name edit box and choose Continue to display the New 
Multiline Style: MYSTYLE dialog box.  

3.	 Enter Wood-frame Wall System in the Description edit box. 

4.	 Select the 0.5 line definition in the Elements list box. In the Offset edit box, replace 0.500 
with 1.00. This redefines the first line which will now be 1.00” above the centerline of the 
wall. 

5.	 Select the -0.5 line definition in the Elements list box. In the Offset edit box, replace -0.500 
with -1.00. This redefines the second line which will now be placed 1.00” below the centerline 
of the wall.

6.	 Choose the Add button; a new line is added with offset value of 0 and is highlighted in the 
Elements list box.

7.	 In the Offset edit box, replace 0.000 with 1.50.

8.	 Select Yellow from the Color drop-down list. 

9.	 Repeat steps 6 through 8, but this time use the value -1.50 in place of 1.50 in step 7 to add 
another line to the current multiline style. The color of this line should be red.
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10.	 Choose the OK button and return to the Multiline Style dialog box. The new multiline 
style is displayed in the Preview of area.

11.	 Choose the Set Current button to make the MYSTYLE as current style.

12.	 Choose the OK button from the Multiline Style dialog box to return to the drawing 
area. To test the new multiline style, use the MLINE command and draw a series of lines 
(Figure 17-15).

Figure 17-15  Multiline style created for Example 1

Creating Revision Clouds
  Ribbon:   Home > Draw > Revision Cloud    or    Annotate > MarkUp > Revision Cloud	  
  Tool Palettes:  Draw > Revision Cloud 		  Toolbar:  Draw > Revision Cloud		  
  Menu Bar:  Draw > Revision Cloud	 	 Command:  REVCLOUD			 

The Revision Cloud tool in the Draw panel is used to create a cloud-shaped polyline, as 
shown in Figure 17-16. This tool can be used to highlight the details of a drawing. The 
prompt sequence that will follow when you choose this tool from the Draw panel is as 

follows:

Minimum arc length: 0.5000   Maximum arc length: 0.5000   Style: Normal
Specify start point or [Arc length/Object/Style] <Object>: Specify the start point of the revision 
cloud.
Guide crosshairs along cloud path...

As you move the cursor, different arcs of the cloud with varied radii are drawn. When the start 
point and endpoint meet, the revision cloud is completed and you get a message. 

               Revision cloud finished.

You can define the length of the arcs to be drawn using the Arc length option. Also, all the 
arcs drawn are of constant length. You can convert a closed loop into a revision cloud using the 
Object option. Note that the selected closed loop should be a single entity such as an ellipse, 
a circle, a rectangle, a polyline, and so on. The Style option is used to define the arc style for 
the revision cloud. The default style is Normal that creates a revision cloud similar to the one 
shown in Figure 17-16. You can change the style to Calligraphy to create a revision cloud similar 
to the one shown in Figure 17-17.
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Note
The REVCLOUD stores the last used arc length in the system registry. This value is multiplied 
by the DIMSCALE value to provide consistency when the program is used with drawings that 
have different scale factors.

Figure 17-17  Calligraphy revcloudFigure 17-16  Creating revcloud

Creating Wipeouts
  Ribbon: Home > Draw > Wipeout or Annotate > Markup > Wipeout 	  
  Command:  WIPEOUT							     

The Wipeout tool is used to create a polygonal area to cover the existing objects with the current 
background color. The area defined by this command is governed by the wipeout  frame. The 
frame can be turned on and off for editing and plotting the drawings, respectively. This tool 
can be used to add notes and details to a drawing. The prompt sequence that will follow when 
you choose the Wipeout tool from the Draw panel is as follows:

Specify first point or [Frames/Polyline] <Polyline>: Specify the start point of the wipeout.
Specify next point: Specify the next point of the wipeout.
Specify next point or [Undo]: Specify the next point of the wipeout.
Specify next point or [Close/Undo]: Specify the next point of the wipeout.

Figure 17-18 shows a drawing before creating a wipeout and Figure 17-19 shows a drawing after 
creating the wipeout. 

Figure 17-18  Drawing before creating a wipeout Figure 17-19  Drawing after creating a wipeout

If you do not want the frame of the wipeout to be displayed, enter F at the Specify first point 
or [Frames/Polyline] <Polyline> prompt and turn the frame off. The display of frames of 
all existing wipeouts will be turned off. Also, the display of frames of all new wipeouts will be 
turned off.
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Creating NURBS
  Ribbon:  Home > Draw > Spline Fit	 Menu Bar:  Draw > Spline > Spline Fit	      	  
  Tool Palettes:  Draw > Spline		  Toolbar: Draw > Spline     Command:  SPLINE	

The NURBS is an acronym for Non-Uniform Rational Bezier-Spline. These splines are 
considered true splines. In AutoCAD LT, you can create NURBS using the Spline tool. 
The spline created with the Spline tool is different from the spline created using the 

Polyline tool. The nonuniform aspect of the spline enables the spline to have sharp corners 
because the spacing between the spline elements that constitute a spline can be irregular. Rational 
means that irregular geometry such as arcs, circles, and ellipses can be combined with free-form 
curves. The Bezier-spline (B-spline) is the core that enables accurate fitting of curves to input 
data with Bezier’s curve-fitting interface. Not only are spline curves more accurate compared to 
smooth polyline curves, but they also use less disk space. 

The prompt sequence to draw a spline with six fit points is given below.

Command: _SPLINE
Current settings: Method=Fit   Knots=Chord
Specify first point or [Method/Knots/Object]: Select point P1
Enter next point or [start Tangency/toLerance]: Select point P2.
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P3.
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P4
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P5.
Enter next point or [end Tangency/toLerance/Undo/Close]: Select point P6 and press 
ENTER to end the process of point specification

Options for Creating Splines
The options under this command for creating splines are as follows:

Object
This option allows you to change a 2D  spline-fitted polyline into a NURBS spline. The original 
splined polyline is deleted if the system variable DELOBJ is set to 1, which is the default value 
of the variable. You can change a polyline into a splined polyline using the Spline option of 
the Edit Polyline tool.

Method
In AutoCAD LT, you can create a spline by specifying fit points or control vertices. By default, a 
spline is created by specifying the fit points. Fit points are the points through which the spline 
will pass. Control vertices determine the shape of the curve. To set the method to create a 
spline, enter M at the Specify first point or [Method/Knots/Object] prompt. Then, you need 
to specify the method at the Enter spline creation method [Fit/CV] prompt. Figure 17-20 shows 
the spline created by using the Fit method. Figure 17-21 shows the spline created by using the 
CV method. 

Note
On selecting a spline, a grip will be displayed at the start point of the spline. Left-click on the 
grip; a shortcut menu will be displayed. Now, you can choose the appropriate option to display 
the fit points or the control vertices, as shown in Figure 17-22. 
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Figure 17-20  Spline drawn by using the Fit 
method

Figure 17-21  Spline drawn by using the CV 
method

Knots
If you have selected the Fit method, the Knots option will be displayed at the Command prompt, 
as given below.

Enter spline creation method [Fit/CV] <CV>: FIT
Current settings: Method=Fit   Knots=Uniform
Specify first point or [Method/Knots/Object]:

You can specify three types of knots: Chord, Square root, and Uniform. Figure 17-23 shows the 
splines formed by using three different knot options.

Figure 17-23  Splines with different knot optionsFigure 17-22  Control vertices and fit points of a 
spline

Degree
If you have selected the CV method, then the Specify first point or [Method/Degree/Object] 
prompt will be displayed. Enter D at the Command prompt and specify the degree.

Close
This option allows you to create closed NURBS. When you use this option, AutoCAD LT will 
automatically join the endpoint of the spline with the start point, and you will be prompted to 
define the start tangent only. 

Tolerance
This option is used to control the fit of the spline between specified points. By default, this value 
is zero; as a result, the spline passes through the points by which it is created. Using this option, 
you can specify the tolerance values that will govern the spline creation, see Figure 17-24. The 
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splines will be offset from the specified point by a distance equal to the tolerance value. The 
smaller the value of the tolerance, the closer the spline will be to the specified points. 

Start and End Tangency
This option is used to control the tangency of a spline at its start point and the endpoint.  On 
entering T at the Enter next point or [start Tangency/toLerance] or Enter next point or [end 
Tangency/toLerance/Undo/Close] prompt, you will be prompted to specify the tangent. Specify a 
point; the tangency will be determined by the slope of the spline at the specified point. Remember 
that after specifying the start point of the spline, you need to specify the start tangency. If you 
specify the second point, the default value will be used for the tangency. Similarly, you need to 
specify the end tangency after specifying the last point of the spline. Figure 17-25 shows the 
spline with start and end tangencies. The virtual tangent line is for reference.

Figure 17-24  Creating a spline with the 
Tolerance of 0 and 3

Figure 17-25  Spline with start and end 
tangencies

Editing Splines
  Ribbon:  Home > Modify > Edit Spline	    Menu Bar: Modify > Object > Spline	  
  Tool Palettes:  Modify > Edit spline	    Toolbar:     Modify II > Edit Spline	  
  Command:  SPLINEDIT								     

The NURBS can be edited using the Edit Spline tool. Using this tool, you can fit data in 
a selected spline, close or open a spline, move vertex points, and refine or reverse a spline. 
Apart from the ways mentioned in the preceding command box, you can use the options 

available in Spline flyout from the shortcut menu that is displayed when you select a spline and 
right-click. The prompt sequence that will follow when you choose the Edit Spline tool in the 
Modify panel is given next.

Select spline: Select the spline to be edited if not selected already, using the above-mentioned shortcut 
menu.
Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: Select any one of the options.

Options for Editing Splines
The options under this command for editing the splines are described next.

Fit data
When you draw a spline, the spline is fit to the specified points (data points). The Fit data option 
allows you to edit these points. You can add, delete, or move the data points. These data points 
or control points are also referred to as fit points. For example, if you want to redefine the start 
and end tangents of a spline, select the Fit data option, and then select the Tangents option. 
The prompt sequence that will follow when you invoke this option is given next.
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Select spline: Select the spline to be edited.
Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>:  F
Enter a fit data option [Add/Close/Delete/Kink/Move/Purge/Tangents/
  toLerance/eXit] <eXit>: T

The start and end tangent points can be selected or their coordinates can be entered. The 
options available within the Fit data option are as follows:

Add. You can use this option to add new fit points to the spline. When you invoke this option, 
you will be prompted to specify the existing fit point on the spline. After selecting the existing 
fit point, you will be prompted to specify the location of the new control points. The fit point 
you select and the next fit point appear as selected grips. You can now add a fit point between 
these two selected fit points, as shown in Figure 17-26. If you select the start point or endpoint 
of the spline, only those points are highlighted. When you select the start point of the spline, 
you are prompted to specify whether you want to add the new fit point before or after the start 
point of the spline. AutoCAD LT will continue prompting for the location of new control points 
until you press ENTER at the Specify new point <exit> prompt.

Close/Open. This option is used to close an open spline or open a closed spline, see Figure 17-27. 
If the spline is open, the Close option is available and if the spline is closed, the Open option 
is displayed.

Figure 17-26  The original spline and the 
edited spline after adding fit points

Figure 17-27  An open spline and a closed spline

Delete. This option is used to delete a selected fit point from a spline. You can continue deleting 
fit points from a spline until only two fit points are left in the spline.

Kink. This option is used to add a knot and a fit point to the selected point. On selecting this 
option, you will be prompted to specify a point on the spline. Select a point; a kink will be 
added.

Move. You can move fit points by using this option. When you select this option, the start point 
of the spline is highlighted and the following prompt sequence appears:

Specify new location or [Next/Previous/Select point/eXit] <N>: Select a new location for the 
start point using the mouse pick button or enter any one of these options.

You can enter N if you want to select the next point, P if you want to select a previous point, 
or S if you want to select any other point. If you enter X at the preceding prompt, you can exit 
the command. Figure 17-28 shows the movement of data points in a spline. Remember that 
this option is used to move only the data points on the spline and not the control points on the 
Bezier control frame.
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Purge. This option is used to remove fit point data from a spline. This reduces the file size, 
which is useful when a drawing, for example, a landscape contour map, contains large number 
of splines. Purging simplifies the spline definition and the drawing file size.

Tangents. This option is used to modify the tangents of the start and endpoints of a selected 
spline, see Figure 17-29. When you select this option, you will be prompted to specify the start 
and end tangents for the spline. You can specify the start and end tangents or use the systems 
default tangents.

Figure 17-28  The original spline and the 
edited spline after moving the data points

Figure 17-29  The original spline and the spline 
after modifying the start and end tangents

toLerance. This option is used to modify the fit tolerance values of a selected spline. As discussed 
while creating the splines, different tolerance values produce different splines. A smaller tolerance 
value creates a spline that passes very closely through the definition points of a spline. When 
you invoke this option, you will be prompted to specify the tolerance value for the spline. 

eXit. This option is used to exit the Fit data option of editing splines.

Close/Open
This option is used to close an open spline or open a closed spline. When you select the Close 
option, AutoCAD LT lets you open, edit the vertex, covert spline to poyline, or reverse the 
spline. 

Edit Vertex
This option is used to refine a spline by adding more control points in it, elevating the order, 
or adding weight to vertex points. The prompt sequence that will follow when you invoke this 
option is given next.

Enter an option [Open/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E
Enter a vertex editing option [Add/Delete/Elevate order/Move/Weight/eXit] <eXit>:

The options in this prompt are discussed next. 

Add. This option is used to add more control points on the spline. When you invoke this option, 
you will be prompted to specify the location of the new point on the spline. You can directly 
specify the location of the new point using the left mouse button. A new control point will be 
added at the specified location.

Delete. This option is used to delete a selected fit point from a spline.

Elevate order. This option is used to increase the order of a spline curve. An order of the curve 
can be defined as the highest power of the algebraic expression that defines the spline plus 1. 
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For example, the order of a cubic spline will be 3 + 1 = 4. Using the Elevate order option, you 
can increase this order for a selected spline. This results in more control points on the curve 
and a greater possibility of controlling the spline. The value of the spline order varies from 4 
to 26. You can only increase the order and not decrease it. For example, if a spline order is 18, 
you can elevate its order to any value greater than 18, but not less than 18.

Move. When you draw a spline, it is associated with the Bezier control frame. The Move vertex 
option allows you to move the vertices of the control frame. The Move option is similar to the 
Move option of the Fit data option of editing the splines. The prompt sequence that follows 
when you invoke this option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E
Enter a vertex editing option [Add/Delete/Elevate order/add Kink/Move/Weight/eXit] 
<eXit>: M
Specify new location or [Next/Previous/Select point/eXit] <N>:

Weight. You can also add weight to any of the control vertices of a spline by using this option. 
When weight is added to a particular vertex, the spline gets pulled more towards it. Similarly, 
a lower value of weight of a particular spline vertex will result in the spline getting pulled less 
towards that particular vertex. In other words, adding weight to a particular point will force the 
selected point to maintain its tangency with the point. The more weight added to the point, the 
more is the distance through which the spline will remain tangent to the point. By default, the 
spline gets pulled equally towards the vertices of the spline. The default value of weight provided 
to each control point is 1.0 and can have only positive values. Once you have added the weight 
to a point, you can proceed to the next point. You can also directly select the point to which the 
weight has to be added. The prompt sequence for using this option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: E
Enter a vertex editing option [Add/Delete/Elevate order/Move/Weight/eXit] <eXit>: W
Spline is not rational. Will make it so.
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: S
Specify existing fit point on spline <exit>: Select a fit point
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: 3
Enter new weight (current = 1.0000) or [Next/Previous/Select point/eXit] <N>: Exit

Join
If a spline, line, or an arc is joined to the spline that is being edited, then you can use this option 
to join those entities to the spline. On choosing this option you will be prompted to select an 
open curve. Select the curves to be joined and press ENTER; all curves will be joined to the 
spline, and knot and fit point will be added at the joining point. The prompt sequence for using 
this option is given next.

Enter an option [Close/Join/Fit data/Edit vertex/convert to Polyline/Reverse/Undo/eXit] 
<eXit>: J
Select any open curves to join to source: Select an object. 1 found
Select any open curves to join to source: Select an object. 1 found, 2 total
Select any open curves to join to source:
2 objects joined to source 
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Reverse
This option is used to reverse the spline direction. This implies that when you apply this option 
to a spline, its start point becomes its endpoint and vice versa. 

convert to Polyline
This option is used to convert a spline into a polyline. On specifying this option, you will be 
prompted to specify a precision value. Specify a value between 0 and 99, and then press ENTER; 
the spline will be converted into a polyline. The precision value determines the accuracy of the 
resulting polyline. 

Undo
This option will undo the previous editing operation applied to a spline within the current 
session of the SPLINEDIT command. You can continue to use this option till you reach the 
spline as it was when you started to edit it.

  Self-Evaluation Test	
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 The name of the multiline style that you enter in the New Style Name edit box of the Create 
New Multiline style dialog box can have up to thirty-one characters including spaces. 
(T/F)

2.	 The Zero option is used to create a multiline so that the zero offset position of the multiline 
coincides with the selected points. (T/F)

3.	 Multilines cannot be edited using grips. (T/F) 

4.	 While using the Top justification option to draw a multiline, the line with the largest positive 
offset coincides with the points selected on the screen. (T/F) 

5.	 When a multiline is cut, two separate multilines are created. (T/F) 

6.	 The maximum number of lines that can be added to a multiline style is __________.

7.	 While using the Inner arcs option for multilines, a capping arc is drawn between the 
__________ numbered inner lines.

	
8.	 The Multilines Edit tools dialog box consists of __________ basic editing tools.

9.	 The __________ option of the Fit data option of the Edit Spline tool is used to reduce the 
file size by removing the fit data of the selected splines.

10.	 The __________ system variable stores the justification of the current multiline.
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  Review Questions	
Answer the following questions:

1.	 By default, the .mln files are saved at the location Autodesk\AutoCAD LT 2013-English\R19.0\
enu\Support. (T/F)

2.	 Once the Purge option of the Fit data option of the SPLINEDIT command is used on a 
spline, it becomes difficult to edit the spline and the Fit data option of the SPLINEDIT 
command is no longer available for the particular spline. (T/F)

3.	 You can break or trim a multiline. (T/F)

4.	 You cannot change the lineweights of the lines that constitute a multiline. (T/F)

5.	 You cannot weld or join separate multilines. (T/F)

6.	 In which file are the multiline styles saved by default?

		  (a) acadlt.mln			   (b) acadlt.pat
	 (c) acadlt.mpr			   (d) acadlt.plt

7.	 Which of the following is the default value of the start and end angles for multilines?

	 (a) 90				    (b) 180
	 (c) 45				    (d) 0

8.	 Which of the following commands does not work on multilines?

	 (a) MIRROR			   (b) FILLET
	 (c) STRETCH			   (d) EXPLODE

9.	 Which of the following options can be used to reverse the direction of spline creation while 
editing a spline?

	 (a) Fit data			   (b) Refine
	 (c) Reverse			   (d) Weight

10.	 AutoCAD LT forces a multiline to turn into a single line if the scale factor of the multiline 
is_______.

11.	 The current multiline style is saved in the __________ system variable and the default value 
is STANDARD.

12.	 Three justifications are available for the MLINE command. They are __________, __________, 
and __________.

13.	 Using the MLEDIT command options, you can create three types of cross intersections. 
They are __________, __________, and __________.

14.	 If value of Fit tolerance of a spline is __________, the spline passes exactly through the fit 
points of the spline.
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15.	 You need to set the degree of a spline, if you are drawing the spline by using the __________ 
method. 

Exercise 1
Create the drawing shown in Figure 17-30. Assume the missing dimensions.

Figure 17-30  Drawing for Exercise 1

Exercise 2
Create the drawing shown in Figure 17-31. Use the MULTILINE command to draw the walls. 
The wall thickness is 12 inches. Assume the missing dimensions. 
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Problem-Solving Exercise 1
Create the drawing shown in Figure 17-32. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions. 
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Problem-Solving Exercise 2
Create the drawing shown in Figure 17-33. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions.
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Problem-Solving Exercise 3
Create the drawing shown in Figure 17-34. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions. 
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Problem-Solving Exercise 4
Create the drawing shown in Figure 17-35. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions.
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Problem-Solving Exercise 5
Create the drawing shown in Figure 17-36. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions. 
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Problem-Solving Exercise 6
Create the drawing shown in Figure 17-37. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions.
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Problem-Solving Exercise 7
Create the drawing shown in Figure 17-38. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions.

Figure 17-38  Drawing for Problem-Solving Exercise 7
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Problem-Solving Exercise 8
Create the drawing shown in Figure 17-39. Some of the reference dimensions are given in the 
drawing and you need to assume the missing dimensions.
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 Answers to Self-Evaluation Test	
1. T, 2. T, 3. F, 4. T, 5. F, 6. 16, 7. even, 8. five, 9. purge, 10. CMLJUST


